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 PREPARATION DE DOCUMENTS TECHNIQUES

Cette correction comporte 14 pages A4

ELEMENTS DE CORRECTION

Il convient de prendre en compte la justesse des candidats, mais également
la cohérence de leur raisonnement et la faisabilité de leur proposition.

Baréine sur 120 points
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A — PREPARATION DES ELEMENTS VECTORIELS

A-1 Le visuel de la premiére de couverture, [page 17 » 1]
représente une pelote de fil de texte, formant une liste de
noms d’artistes contemporains.

A-1. a Décrivez précisément les outils et les différentes étapes nécessaires a la réalisation de ce
visuel, sachant qu’il a été réalisé avec le logiciel de dessin vectoriel.

1/ véaliser un tracé avec Poutil Plume ; :
2/ utiliser 'outil Texte curviligne, de maniére a saisir les caractédres sur le tracé ;
3/ régler le choix de la police de caractére, le corps, I'interfettrage.

A-1.b Sous quel format d’enregistrement devra-t-on enregistrer ce visuel, en vue de son
importation dans un logiciel de mise en page ?

En EPS.

A-1. ¢ Quelle précaution devra-t-on prendre avant d’enregistrer le fichier, de maniére a supprimer
des problémes au flashage, comme des problémes de chasse par exemple ?

Il faudra vectoriser le texte.
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contemperary art fair

A-2 La 2° de couverture représente une annonce presse pour
le palmbeach3, foire d’art contemporain aux Etats-Unis.

Les trois cercles de couleur symbolisent chacun un des axes
développés a travers cette manifestation : photographie, vidéo,
et installation d’art et de design.

A-2.a Le cercle vert est constitué de deux éléments :

- un filet plein (a)

- un filet tramé par la répétition de tirets (b)

Le filet (b) a été réalisé en créant une nouvelle forme de motif.
Expliquez la procédure, les menus et outils nécessaires a

la création du cercle (b).

al Créer un cercle :

outil ellipse + touche maj pour conserver I'homothétie.
- Sélectionner une couleur dans le nuancier.

- Sélectionner le cercle, double-cliquer sur lI'outil Mise &
I'échelle en appuyant sur Alt. Dans la boite de dialogue,
indiquer un taux de réduction (80%) et cliquer sur

la touche “copier”.

b/Créer une forme :
- Créer un petit tiret vertical de la méme couleur que le
premier cercle.
- Cliquer sur la fleche option pour obtenir "Nouvelle
Forme"”.
- Choisir "Nouvelle forme de motif”. Indiquer un
pourcentage de pas environ 400 %

- Appliquer la forme au contour.

AUTRE SOLUTION pour b) :

Palette contour. Créer des pointillés & partir d’un filet qui a
une certaine épaisseur (exemple : tiret = 1 pt, blanc = 8 pt,
épaisseur contour = 10 pt).

A-2.b Le cercle rose est composé de plusieurs €léments
vectoriels qui se superposent. A chaque élément est attribué

la couleur Magenta, mais dans des proportions différentes.
Nommez la palette nécessaire et décrivez comment vous procédez
pour obtenir ces variations de teinte.

Les trois formes sont superposées et sont toutes de couleur Magenta.
Dans la palette Couleur, faire varier le pourcentage de teinte et le pourcentage d'opacité
ou le mode de fusion de la palette Transparence. .
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A-2. ¢ Retracez directement sur I’image ci-dessous [page 17 » 5] les points d’ancrage

et les lignes directrices nécessaires a la vectorisation de ce cercle bleu.

A-2. e Le fond noir de I’annonce presse [page 17 » 2] a été densifié pour obtenir un contraste plus
fort avec les couleurs vives. On appelle alors ce noir : un noir soutenu ou un noir profond ou

Couleurs Benday.
Autre réponse : couleur tramée.

enrichi. Expliquez comment on obtient une telle couleur.

profonde.

A-2.d La teinte du cercle bleu est obtenue a partir du mélange de
deux couleurs primaires ; 100 % de Cyan et 25 % de Magenta.
Comment appelle-t-on une couleur obtenue par superposition
des teintes primaires ?

On obtient un noir enrichi lorsqu’on combine une encre noire a une ou
plusieurs autres encres pour produire une couleur noire plus sombre et plus
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A-3 Le bandeau de la page sommaire [page 17 P 6] est réalisé avec la combinaison de deux éléments
vectoriels : un rectangle (a) plus une silhouette de personnage (b).

Décrivez la procédure, palette et outils nécessaires pour combiner ces deux éléments et obtenir un
seul tracé fermé (c) dans le logiciel de dessin vectoriel.

Sélectionner le rectangle et le positionner sur la partie gauche
du personnage. Sélectionner les deux éléments. Dans la
palette Pathefinder, cliquer sur « Ajout a la forme » puis sur

« Décomposer ».

B — PREPARATION DES ELEMENTS BITMAP

B-1 Cet élément graphique [page 18 P 8] a ét¢ imprimé en Noir sur le fond
uni de la premié¢re de couverture. Il ne présente aucune variation de gris.

B-1. a Comment nomme-t-on ce type d’élément en 1 bit qui ne présente
que des valeurs extrémes : du noir et du blanc ?

Image bitmap ou document au trait.
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B-1.b Décrivez la procédure et les menus qui permettent de transformer une image RVB
3 en image 1 bit, dans le logiciel de traitement d’image.

1/ transformer le mode RVB de I'image en mode Niveaux de gris : Menu Image >
Mode > Niveaux de gris ;

2/ transformer le mode Niveaux de gris en mode Bitmap : Menu image > Mode >
Bitmap ;

3/ dans la boite de dialogue choisir Seuil 50% ;

B-1. ¢ Indiquez quelle doit étre la résolution d’une image en 1 bit, pour que sa qualité soit optimale

et éviter les effets d’escalier a I’impression.
Résolution du périphérique de sortie : au moins 1200 ppp.
B-1.d Indiquez dans quel format d’enregistrement cette image en 1 bit devra étre sauvegardée, en
vue de son importation dans un logiciel de mise en page.
Sauvegarde en Tiff.

' B-2 Ce photomontage [page 18 P 9] a été réalisé 4 partir de deux
photographies RVB différentes, celles d’un pére et de son fils. Elles ont été
assemblées de maniére & créer un surprenant personnage. La fusion entre
les deux visuels semble parfaite, car aucune séparation n’est perceptible.
B-2. a Aprés avoir observé la palette de calques ci-dessous, expliquez la
méthode, palette et outils utilisés, pour la réalisation de ce photomontage.

' Chaque photo se trouve sur un calque séparé.

1/ Sur le calque de ta photo 2, ajouter un masque de fusion, en
cliquant sur Ficdne correspondante en bas de la palette caique.
2/ Créer un dégradé du noir vers le blanc verticalement, dans le
masque. Ajuster.

3/ Retoucher et affiner avec I'outil tampon.

4/ Finaliser en réglant la chromie.
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B-2. b La partie haute du crane semble étre isolée et collée sur I’ensemble
du montage. Cet effet est renforcé par la présence d’une ombre portée.
Expliquez la méthode, menus et outils nécessaires a la réalisation d’une

. ombre portée dans le logiciel de traitement d’image bitmap.

1/ Sur le calque Photo1, avec 'outil Rectangle de sélection tracer une
zone sur le haut du front.

2/ Copier (Ctrl C), coller (Ctrl V). La sélection s’est collée sur un autre
calque.

3/ Attribuer un Style de calque > Ombre portée en cliguant sur l'icéne
correspondante en bas de la palette calque. Régler les paramétres de
I’'ombre (couleur, opacité, distance ...)

[page 18 » 9]

B-2. ¢ Une fois le photomontage terminé, quelle opération doit-on effectuer sur I’image afin
qu’elle puisse étre imprimable ?

Effectuer la séparation de couleur : passer 'image en mode CMJN.

B-2. d Dans quel format devra-t-on I’enregistrer en vue de son importation dans le logiciel de mis
en page ? .
Sauvegarde en Tiff (ou EPS).

B-3 Cette photo représente Anne-Catherine Beckerd-Echivard dans son
studio de création. L’image est une fausse bichromie, ¢’est-a-dire qu’elle
a été colorisée directement dans le logiciel de mise en page (violet + noir).
Expliquez précisément les étapes, menus et outils qui permettent de
transformer une image RVB, en image colorisée dans un logiciel de mise

en page.

1/ Dans Photoshop, passage de I'image en mode Niveaux de gris :
Menu Image > Mode > Niveaux de gris. Sauvegarde en Tiff.

2/ Dans logiciel mise en page : créer la couleur violet, palette
Nuancier > Nouvelle Nuance.

[page 18 » 10] 3/ Attribuer la couleur Violet au fond du bloc, en sélectionnant
'image avec outil déplacement (XPress) ou sélection (Indd).

4/ L’image s’affiche en noir sur fond Violet.
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B-4 Assa Ashuach est le créateur d’un luminaire « A7 light » qui change de forme et de comportement en
réagissant aux mouvements et aux bruits de la piéce ou il est installé.

Pour illustrer ce phénomene, ’article [page 18 » 11] présente deux fois ce luminaire ; d’abord statique (a),
puis en mouvement (b).

b

Le visuel (b) a été réalisé a partir du visuel (a). Expliquez la procédure, menus et outils nécessaires
a sa réalisation dans le logiciel de traitement d’image bitmap.

1/ Le mouvement est traduit par la superposition de I'image qui est dupliquée sur différents calques.
Chaque calque est en mode de fusion « éclaircir » ne laissant apparaitre que les zones claires de
Pimage.

2/ Chaque élément a subi une rotation : sélection de I'objet sur chacun des calques, Menu Edition >
Transformation > Rotation.

3/ Chaque calque présente un degré d’opacité différent.
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C — PREPARATION DES DOCUMENTS DANS LE LOGICIEL DE MISE EN PAGE
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C-1 La premiére de couverture est imprimée en noir sur un fond uni
Pantone Warm Red M. [page 17 b 1]

Expliquez la procédure pour créer une couleur de ton direct dans le logiciel
de mise en page.

Dans Indd :

Palette Nuancier, cliquer sur la fléche d’option. Sélectionner Nouvelle
Nuance. Dans la boite de dialogue, dans le champs Type de couleur,
choisir Tons Direct. Sélectionner le type de Pantone (Solid Coated).
Saisir la référence dans le champ.

Dans XPress :

Dans le menu Edition, choisir Couleur. Sélectionner Créer. Dans la boite
de dialogue, dans le champ Modéle, sélectionner Pantone Solid Coated.
Sélectionner Warm Red. Cocher Couleur d’accompagnent. Valider.
Enregistrer.

C-2 Le sommaire fait ’objet d’une mise en forme du texte particuliére.
[page 19 » 12

C-2. a Nommez la fonction du logiciel qui permet une telle mise en forme.

Il s’agit des Tabulations

C-2.b Expliquez précisément la méthode pour utiliser cette fonction du logiciel de mise en page.

Sélectionner le paragraphe concemné, puis appeler la boite de dialogue Tabulation.

XPress : Menu Style> Tabulations ou Menu Style > Format > Onglet tabulations.

indd : Menu Texte > Tabulations. Aimanter la palette en cliquant sur P'ic6ne Aimant.
Cliquer sur I'ic6ne correspondant au taquet droit, le faire glisser sur la régle a trois reprises,
ou saisir une valeur dans ie champ Position.
Taper sur la touche tabulation « TAB ->» pour mettre en action les taquets de tabulation.

C2c S@O® 19> 12] Ce symbole graphique est un élément intégré au texte du

sommaire.

a) Comment nomme-t-on ce type d’élément intégré au texte ?
ii s’agit d’'un bloc ancré.

1 b) Expliquez précisément la méthode qui permet de lier un élément graphique dans un bloc de

texte, dans le logiciel de mise en page.

Sélectionner ’élément, le copier {avec Foutil déplacement XPress), cliquer sur Poutil
Texte, insérer le curseur texte 14 ol devra &tre inséré P’élément, puis coller. Le texte et
IPélément graphique sont liés.
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C-3 Certains éléments comme les filets et titres courants sont présents sur chaque page du

magazine.
Filets et titres courants

Soesesnmrnvonsssnassensneswe?

[page 19 » 13]

C-3. a Expliquez précisément la procédure a suivre pour automatiser et simplifier la mise en place
2 de ces éléments dans le logiciel de mise en page.

Il faut créer et mettre en place ces éléments, sur les pages Maquette (XPress) ou Gabarit
(Indd). , ,

C-3. b Expliquez précisément la procédure a suivre pour créer des folios automatiques dans le
logiciel de mise en page.

Dans Indd :

Sur la page Gabarit, créer un bloc de texte. Cliquer avec I'outil Texte pour insérer un
caractére spécial : Menu Texte > Insérer un caractére spécial > Numérotation automatique
des pages. Attribuer les spécifications de police, de corps et de couleur.

Dans XPress :

Sur la page Maquette, créer un bloc de texte, taper Ctrl + 3 (Wind) ou Cmd + 3 (Mac Os).
Attribuer les spécifications de police, de corps et de couleur.

C-4 Le bloc de texte de cet article est composé de telle maniére qu’il
suit le contour de I’objet présenté en illustration.

Expliquez précisément la méthode, menus et outils qui permettent
d’obtenir ce type de mise en forme du texte dans le logiciel de mise en
page. Vous expliquerez dans un premier temps, ce que doit subir l’nnage
dans le logiciel de traitement d’image avant d’étre importée.

C-4, a Préparation de I’image avec le logiciel de traitement d’image :

Il faut créer un tracé vectoriel, outil Plume. Dans la palette Tracé,
sélectionner la fléche d’option et choisir Mémoriser le tracé, puis dans
[page 19 » 14] la boite de dialogue, le nommer. A nouveau dans la fleche d’option,
sélectionner Masque. Veiller a ce que 'image soit en CMJN.
Sauvegarder en Eps.

C-4. b Mise en forme du bloc texte avec le logiciel de mise en page :

4 Dans Indd :
1/ Importer I’image, le détourage est fait automatiquement. Si ce n’est pas le cas, sélectionner
Masque dans le menu Objet. Dans la boite de dialogue, choisir « Tracé Photoshop ».
2/L’objet est sélectionné. Appeler la palette Habillage, cliquer sur I'icone « Habiller la forme de
Pobjet ». Le texte suit alors le contour du tracé de détourage.
Dans XPress :
Créer un bloc image, importer Pimage. Le détourage est fait automatiquement, si ce n’est pas
le cas, sélectionner Menu Bloc > Modifier. Dans Ponglet Habillage, choisir Chemin imbriqué,
ou couche Alpha.
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pepipphrarayecierion C-4. ¢ Expliquez comment s’obtient le décalage visible entre I’objet et le

Sk 4 11asees B thiley, s dusaions ¢

'ﬁ”ﬁ“;.:‘:".;“‘...: texte qui le suit dans le logiciel de mise en page :

R pritiet Dans Indd :

ot - ebeer e Le visuel est sélectionné, appeler la palette Habillage. Dans chacun
e — des champs « Décalage » saisir une valeur numérique.
Loty e Dans XPress :
it apmpprin Dans I'onglet Habillage, (Menu Bloc > Habillage), dans le champs
e g, s s ot et 3 e « Réserve ext. » saisir une valeur en point.
[page 19 » 14]
tus qu'on m

ot de scks C-5 Cet article débute par une lettrine. [page 19 b 15}
partors colc Expliquez précisément la procédure, menus et outils nécessaire pour créer

m‘:‘: une lettrine en début de paragraphe, dans le logiciel de mise en page.
sujourd tus, { el .
© wate Dans Indd :

indiquer le nombre de caractéres (ici 1)et de lignes en lettrine (ici 5).
Dans XPress :

Dans le menu Style, sélectionner Format. Dans la boite de dialogue cocher
Lettrine. Indiquer le nombre de caractéres et de lignes en lettrine.

C-6 Le visuel de I’opéra de Pékin est imprimé a cheval sur une « fausse double » page.
[page 20 » 16]

C-6. a Quelle est la différence entre « fausse double » et
une vraie double page ?

Une fausse double-page se compose de deux pages
imprimées séparément. Une vrai double-page ne
comporte qu'une seule et méme feuille.

C-6. b Expliquez la procédure a suivre dans le logiciel de mise en page, pour positionner une
image, qui apparait sur une « fausse double » page, de maniére a éviter tout probléme de décalage
ou erreur de repérage a I’impression.

L'image doit &tre scindée en deux. A I'imposition les pages seront séparées, il faut donc que
les deux pages possédent chacune son bloc image.

1/ Créer un bloc sur les deux pages, importer 'image, caler le document, tenir compte du

fond perdu. Dupliquer le bloc sans décalage vertical ni horizontal avec la fonction
dupliquer/déplacer (ou copier/coller sur place). Les deux blocs sont superposés.

2/ La largeur du bloc supérieur est raccourci jusqu’a la marge de couture, le bloc de dessous
sera raccourci en sens inverse. L’image est constituée de blocs distincts parfaitement calés.
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[page 18 » 17]

en page.

Dans Indd :

C-7 Les quatre photos qui introduisent cet article, sont
parfaitement alignées. Expliquez la procédure, menus et
outils qui permettent d’obtenir ce résultat dans le logiciel
de mise en page.

Sélectionner les blocs image, utiliser la fonction
Alignement (indd) : Menu Fenétre > Objet et mise en
page > Alignement

ou la fonction Espacer /Aligner (XPress) : Menu Bloc
> Espacer/Aligner. Saisir les paramétres.

C-8 Dans cet article, 1a mise en forme des paragraphes
présente un « espace apres ».
[page 20 » 18]

C-8. a Expliquez précisément ce que signifie ce terme :
« espace aprés ».

L’ « espace aprés » correspond a I’espace vertical qui
s’ajoute a l'interlignage en fin de paragraphe.

I propose une bonne structuration du texte.

L’ « espace aprés » peut s’ajouter a I'éventuel

« espace avant » du paragraphe suivant.

C-8. b Expliquez précisément, comment on applique un « espace aprés », dans le log1c1el de mise

Dans le menu Texte, sélectionner Paragraphe. Dans la palette Paragraphe (ou dans la barre des
spécifications des paragraphes) saisir la valeur en mm dans le champ « espace aprés ».

Dans XPress :
Dans le menu Style, sélectionner Format. Dans la boite de dialogue, saisir la valeur en mm dans
le champ « espace aprés ».
SUJET _
Repére de ’épreuve Durée Coefficient Page
0906-AMACTA 3H00 1,5 12114




D — PREPARATION EN VUE DU FLASHAGE

[page 20 » 19]

D-1 En fonction du cahier des charges du magasine indiqué page 3,
précisez combien de films ou plaques sont nécessaire a 1’impression
de la double page de couverture.

4 + 1 =CMJN + ton direct

D-2 Page 10 de la revue [page 17 P 7] se trouve un encart publicitaire en deux couleurs : noir et
rouge. En observant attentivement, on constate un léger décalage entre les zones rouges et le fond

noir. :
Quel terme technique emploie-t-on pour ce type de décalage ?

C’est un défaut de repérage.

D-3 Citez au moins six vérifications a effectuer sur 1’ensemble des fichiers avant la remise de votre
dossier au flashage.

Vérifier le bord perdu de 5§ mm.

Les couleurs doivent étre en CMJN {pourcentage arrondi). Pour les couleurs Pantone, cocher
couleur d'accompagnement.

Vérifier les liens .

Vérifier que les blocs textes soient complets (texte masqué).

Pour les imports d'images Tiff, couleur blanc en fond des blocs, importation & 100%.

Ne pas utiliser pour les filets I'attribut maigre mais attribuer une valeur précise en point (> 0.3).
Pour les couleurs Benday, la charge d’encre ne doit pas dépasser 260 %.

Vérifier gue la pagination donne bien des chiffres impairs sur la page de droite.

Ne pas utiliser les styles de caractére (itaque, bold, outline,..).

Vérifier les polices (PostScript 1 ou Opentype).

Vérifier la résolution des images (300 ppp).

Vérifier le format d’enregistrement des images (Tiff ou Eps).

D-4 Expliquez a quoi sert la fonction « Rassembler les infos » (XPress) ou « Assemblage »
(Indesign). :

Cette fonction rassemble automatiquement les fichiers nécessaires a I'imprimeur. Il crée
et organise des dossiers pour les images importées ainsi que pour les polices de
caractéres utilisées. Il génére un rapport détaillé.
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D-5 Qu’appelle-t-on un « RIP » ?
Donnez sa définition et précisez sa fonction.

RIP : Raster Image Processor

C’est un générateur d’image tramée.

Le RIP décode, interpréte les fichiers et définit le nombre et la position des pixels
nécessaires pour reproduire une image. Ensuite, il envoie les signaux électroniques
compréhensibies par I'imageuse pour commander le laser, ce qu’on appelle le « ripage »

ou « ripping ».

E — FACONNAGE

E-1 Comment nomme-t-on le type de reliure utilisé pour ce magazine.
[page 20 » 20]

-C’est un brochage dos carré-collé.

E-2 Ce type de reliure exige une particularité technique a prendre en compte lors de la création du
fichier de mise en page. Laquelle ? ,

Le brochage dos camré-collé nécessite un fraisage et gréquage du dos des cahiers.
Cela permet a la colle une meilleure adhésion sur ’'ensemble du dos de I'ouvrage.
C’est 3 mm qui seront supprimés lors de cette opération. Il convient alors de les
rajouter aux marges de petit fond lors de la création du fichier, dans le logiciel de mis

en page.

E-3 La couverture a subi un « rainage ». Expliquez en quoi consiste cette opération de fagonnage.

Le rainage est une opération qui consiste a appliquer une pression sur une feuille avec
une fine réglette, formant un repére de pliage, pour faciliter le pliage des papiers & fort
grammage.
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